CS304- Object Oriented Programming
LATEST SOLVED MCQS FROM
MIDTERM PAPERS

Nov 07, 2011

MC100401285  Moaaz.pk@gmail.com  MC100401285@gmail.com  Latest Mcqs

CS304-MIDTERM SOLVED MCQS WITH REFERENCES

Muhammad Moaaz Siddiq – MCS (2nd)
mc100401285@gmail.com
Campus:- Institute of E-Learning & Modern
Studies (IEMS) Samundari
Question No: 1 (Marks: 1) - Please choose one
Which part of an object exhibits its state?

► Data  (Page 23)
► Operations
► Any public part
► Any private part

Question No: 2 (Marks: 1) - Please choose one
Inheritance is a way to

► organize data.
► pass arguments to objects of classes.
► add features to existing classes without rewriting them.  (Page 27)
► improve data-hiding and encapsulation.

Question No: 3 (Marks: 1) - Please choose one
Suppose you have been given the following design,
"A person has a name, age, address and sex. You are designing a class to represent a type of person
called a patient. This kind of person may be given a diagnosis, have a spouse and may be alive". Given that the person class has already been created, what of the following would be appropriate to include when you design the patient class?

► registration date and diagnosis  Click here for Detail
► age and sex
► sex and diagnosis
► diagnosis and age

Question No: 4 (Marks: 1) - Please choose one
What problem(s) may occur when we copy objects without using deep copy constructor?

► Dangling pointer
► Memory Leakage
► All of the given  (Page 147)
► System crash

Question No: 5 (Marks: 1) - Please choose one
this pointers are not accessible for static member functions.

► True  (Page 114)
► False
Question No: 6 (Marks: 1) - Please choose one
A static member function cannot be declared.

- Static
- Implicit
- Explicit
- Virtual [Click here for detail]

Question No: 7 (Marks: 1) - Please choose one
______ remain in memory even when all objects of a class have been destroyed.

- Static variables (Page 111)
- Instance variable
- Primitive variables
- None of given

Question No: 8 (Marks: 1) - Please choose one
Friend functions are __________ functions of a class.

- None of given
- object member
- non-member (Page 136)
- data member

Question No: 9 (Marks: 1) - Please choose one
__________, which means if A declares B as its friend it does NOT mean that A can access private data of B. It only means that B can access all data of A.

- Friendship is one way only
- Friendship is two way only
- NO Friendship between classes
- Any kind of friendship

Question No: 10 (Marks: 1) - Please choose one
The statement objA=objB; will cause a compiler error if the objects are of different classes.

- True
- False

Question No: 11 (Marks: 1) - Please choose one
Identify which of the following overloaded operator function’s declaration is appropriate for the given call?
Rational_number_1 + 2.325
Where Rational_number_1 is an object of user defined class Rational_number.

► Rational_number operator+( Rational_number & obj);
► Rational_number operator+(double& obj);  (Page 145)
► Rational_number operator+(Rational_number &obj, double& num);
► operator+(double& obj);

Question No: 12  (Marks: 1)  - Please choose one
Which operator can not be overloaded?

► The relation operator ( >= )
► Assignment operator ( = )
► Script operator ( [] )
► Conditional operator (? : ) (Page 141)

Question No: 13  (Marks: 1)  - Please choose one
To convert from a user-defined class to a basic type, you would most likely use

► a built-in conversion operator.
► a one-argument constructor.
► an overloaded = operator.
► a conversion operator that’s a member of the class.

Question No: 14  (Marks: 1)  - Please choose one
The technique in which we visualize our programming problems according to real life’s problems is called

-------------------
► structured programming
► object oriented Programming  (Page 9)
► procedural programming
► non of the given

Question No: 15  (Marks: 1)  - Please choose one
In object orientated programming, a class of objects cans ____________ properties from another class of objects

► Utilize
► Borrow
► Inherit  Click here for detail
► Adopt
Question No: 16 (Marks: 1) - Please choose one
A C++ class is similar to ------------------

- Structure  
- Header File  
- Library File  
- None of the given

MIDTERM EXAMINATION  
Spring 2010

Question No: 1 (Marks: 1) - Please choose one
What problem(s) may occur when we copy objects without using deep copy constructor?

- Dangling pointer
- Memory Leakage
- All of the given (Page 147)
- System crash

Question No: 2 (Marks: 1) - Please choose one
Suppose that the Test class does not have an overloaded assignment operator. What happens when an assignment a=b; is given for two Test objects a and b?

- The automatic assignment operator is used
- The copy constructor is used  
- Compiler error
- Run-time error

Question No: 3 (Marks: 1) - Please choose one
A static member function can be called, even when a class is not __________.

- Declared
- Define
- Instantiated  
- Called  

C++ How to Program, Fifth Edition (Page 871)

Question No: 4 (Marks: 1) - Please choose one
Identify which of the following overloaded operator function’s declaration is appropriate for the given call?
Rational_number_1 + 2.325
Where Rational_number_1 is an object of user defined class Rational_number.
Rational_number operator+(Rational_number & obj);

Rational_number operator+(double & obj);  (Page 145)

Rational_number operator+(Rational_number & obj, double & num);

operator+(double & obj);

Question No: 5  (Marks: 1)  - Please choose one

_________ provide the facility to access the data member.

► accesser function  (Page 68)
► private function
► inline function
► None of the given

Question No: 6  (Marks: 1)  - Please choose one

Constant objects cannot change their state,

► True  (Page 105)
► False

Question No: 7  (Marks: 1)  - Please choose one

The ________ relationship indicates that an object contains other objects.

► None of given  (Page 53)
► ‘has-a’
► ‘is-a’
► ‘be-

Question No: 8  (Marks: 1)  - Please choose one

Which one of the following features of OOP is used to derive a class from another?

► Encapsulation
► Polymorphism
► Data hiding
► Inheritance  (Page 25)

Question No: 9  (Marks: 1)  - Please choose one

_______ is a relationship

► Inheritance  (Page 25)
► Polymorphism
► abstraction
► encapsulation
Question No: 10 (Marks: 1) - Please choose one
__________ satisfy the condition of polymorphism
► Carbon
► Diamond
► Coal
► all of the given  (Page 56)

Question No: 11 (Marks: 1) - Please choose one
A generalization-specialization relation between classes are implemented using
► data hiding
► friend classes
► encapsulation
► inheritance  (Page 49)

Question No: 12 (Marks: 1) - Please choose one
The >= operator can be overloaded.
► True  (Page 140)
► False

Question No: 13 (Marks: 1) - Please choose one
In order to free the memory occupied by the object, we use -----------
► Constructor
► Destructor  (Page 92)
► Shallow Copy
► Deep Copy

Question No: 14 (Marks: 1) - Please choose one
Which of the following is not an example of multiple inheritances?----------
► Mermaid
► Woman  (Lecture No.5)
► None of the given
► Amphibious Vehicle

Question No: 15 (Marks: 1) - Please choose one
Static variable can be initialized more than once.
► True  Click here for detail
► False
Question No: 16 (Marks: 1) - Please choose one

A generic class showing all the common attributes and a behavior of other classes represents a very important feature in oop called ---------

► Inheritance (Page 26)
► Encapsulation
► Polymorphism
► Abstraction

MIDTERM EXAMINATION
Spring 2010

Question No: 1 (Marks: 1) - Please choose one

We can get only one unique value which can be used by all the objects of that class by the use of,

► static variables

Click here for detail

► dynamic variables
► instance variables
► data members

Question No: 2 (Marks: 1) - Please choose one

A member function having the same name as that of a class and a ~ sign with it is called,

► Constructor
► Getter
► Setter
► Destructor (Page 92)

Question No: 3 (Marks: 1) - Please choose one

Using encapsulation we can achieve

► Information hiding (Page 16)
► Least interdependencies among modules
► Implementation independence
► All of given options

Question No: 4 (Marks: 1) - Please choose one

Inheritance is a way to

► make general classes into more specific classes. (Page 27)
► pass arguments to objects of classes.
► improve data hiding and encapsulation.
► providing class growth through natural selection.
Question No: 5  (Marks: 1)  - Please choose one
Static variable can be initialized more than once.
True
False  (Page 107)

Question No: 6  (Marks: 1)  - Please choose one
For classes with common behavior, you can save effort by placing the common behavior in a ________.
► Derived Class
► Base class  (Page 29)
► Deprived Class
► Named class

Question No: 7  (Marks: 1)  - Please choose one
Which of the following are an advantage of OOP?
► OOP makes it easy to re-use the code
► It provides an ability to create one user defined data type by extending the other
► It provides the facility of defining Abstract data types through which real world entities can be defined better.
► All of the given options  Click here for detail

Question No: 8  (Marks: 1)  - Please choose one
The >= operator can be overloaded.
► True  (Page 140)
► False

Question No: 9  (Marks: 1)  - Please choose one
A static member function cannot be declared.
► Static
► Implicit
► Explicit
► Virtual  Click here for detail

Question No: 10  (Marks: 1)  - Please choose one
Static variables act like a global variable in the context or scope of the class.
► True  click here for detail
► False

Question No: 11  (Marks: 1)  - Please choose one
The compiler won’t object if you overload the * operator to perform division.
► True  Click here for detail
► False
Question No: 12  ( Marks: 1 ) - Please choose one
We can use "this" pointer in the constructor in the body and even in the initialization list of any class if we are careful,

► TRUE
► False

Question No: 13  ( Marks: 1 ) - Please choose one
A C++ class is similar to -----------------

► Structure  [Click here for detail]
► Header File
► Library File
► None of the given

Question No: 14  ( Marks: 1 ) - Please choose one
Which operator can not be overloaded?
► The relation operator ( >= )
► Assignment operator ( = )
► Script operator ( [] )
► Conditional operator (? : )  (Page 141)

Question No: 15  ( Marks: 1 ) - Please choose one
An overloaded operator always requires one less argument than its number of operands.
► True  (Page 896)
► False

Question No: 16  ( Marks: 1 ) - Please choose one
A generalization-specialization relation between classes are implemented using

► data hiding
► friend classes
► encapsulation
► inheritance  (Page 49)

Question No: 17  ( Marks: 1 ) - Please choose one
In OOP a class is an example of _____
► Data Type
► Abstract Type
► User Defined Type  (Page 66)
► None of the given

Muhammad Moaaz Siddiq – MCS (2nd)
mc100401285@gmail.com
Campus: Institute of E-Learning & Modern Studies (IEMS) Samundari
Question No: 18 (Marks: 1) - Please choose one
A class can be identified from a statement by -----------------  
► Noun (Page 58)  
► Pronoun  
► Verb  
► Adverb

Question No: 19 (Marks: 1) - Please choose one
The members of a class that can be accessed without creating the object of the class is called
► Private member  
► Data Member  
► Public Member (How to Program page 983)  
► Static

MIDTERM EXAMINATION  
Spring 2010

Question No: 1 (Marks: 1) - Please choose one
Suppose there is an object of type Person, which of the following can be considered as one of its attributes
► Name  
► Age  
► Work()  
► Both Name and Age (page 13)

Question No: 2 (Marks: 1) - Please choose one
What a derived class can add?
► New data members  
► New member functions and New friend functions  
► New constructors and destructor  
► All of given Click here for Detail

Question No: 3 (Marks: 1) - Please choose one
________ is/are used to access information hidden within an object?
► Interface  
► Private data members  
► Private member functions (Page 69)  
► Both public and private members
Question No: 4 (Marks: 1) - Please choose one
this pointers are not accessible for static member functions.

► True (Page 14)
► False

Question No: 5 (Marks: 1) - Please choose one
A static member function cannot be declared.

► Static
► Implicit
► Explicit
► Virtual  Click here for detail

Question No: 6 (Marks: 1) - Please choose one
C++ compiler does not allow to dynamically allocate memory for objects

► False  Click here for detail
► True

Question No: 7 (Marks: 1) - Please choose one
Given the following class
class Base{
    int Age=33;
}

How you can improve above class with respect to accessing the field Age?

► Define the variable Age as private
► Define the variable Age as protected
► Define the variable Age as private and create a get method that returns it and a set method that updates it
Click here for detail
► Define the variable Age as protected and create a set method that returns it and a get method that updates it

Question No: 8 (Marks: 1) - Please choose one
Friend class and friend function can be used as an alternate to each other

► True  Click here for detail
► False

Question No: 9 (Marks: 1) - Please choose one
Which of the following operators always takes no argument if overloaded?

► /
► -
Question No: 10 (Marks: 1) - Please choose one
Suppose that the Test class does not have an overloaded assignment operator. What happens when an assignment \( a = b \) is given for two Test objects \( a \) and \( b \)?

- The automatic assignment operator is used
- The copy constructor is used
- Compiler error
- Run-time error

Question No: 11 (Marks: 1) - Please choose one
Assume a class C with objects obj1, obj2, and obj3. For the statement \( obj3 = obj1 - obj2 \) to work correctly, if the overloaded - operator must

- take two arguments.
- return a value
- create a named temporary object.
- take four arguments

Question No: 12 (Marks: 1) - Please choose one
Which operator can not be overloaded?

- The relation operator ( \( \geq \) )
- Assignment operator ( = )
- Script operator ( [ ] )
- Conditional operator ( ? : ) (Page 41)

Question No: 13 (Marks: 1) - Please choose one
We achieve independence of internal implementation from its external interface through--------

- Encapsulation
- Information Hiding
- Abstraction
- both encapsulation and information hiding

Question No: 14 (Marks: 1) - Please choose one
Which one of the following is not an object association?

- Simple Association
- Inheritance (Page 49)
- Aggregation
- Composition
Keeping in view the principle of abstraction, which of the above information the company needs to save as employee’s record?

- 2, 4
- 1, 3, 5
- **1, 2, 3** (Lecture No.3)
- 1, 2, 3, 4

Question No: 4  (Marks: 1)  - Please choose one

What a derived class can add?

- New data members
- New member functions and New friend functions
- New constructors and destructor
- **All of given**  
  [Click here for Detail]

Question No: 5  (Marks: 1)  - Please choose one

The concept of derived classes is involved in,

- inheritance  
  [Page 25]
- encapsulation
- structure
- array

Question No: 6  (Marks: 1)  - Please choose one

Your chief Software designer has shown you a sketch of the new Computer parts system she is about to create. At the top of the hierarchy is a Class called Computer and under this are two child classes. One is called LinuxPC and one is called WindowsPC. The main difference between the two is that one runs the Linux operating System and the other runs the Windows System (of course another difference is that one needs constant re-booting and the other runs reliably). Under the WindowsPC are two Sub classes one called Server and one Called Workstation. How might you appraise your designers work?

- Give the goahead for further design using the current scheme
- **Ask for a re-design of the hierarchy with changing the Operating System to a field rather than Class type**  
  [Click here for detail]
- Ask for the option of WindowsPC to be removed as it will soon be obsolete
- Change the hierarchy to remove the need for the superfluous Computer Class.

Question No: 7  (Marks: 1)  - Please choose one

Consider the code below,

class Fred {
public:
Fred();
};

Muhammad Moaaz Siddiq – MCS (2nd)
mc190401285@gmail.com
Campus: Institute of E-Learning & Modern Studies (IEMS) Samundari
int main()
{
Fred a[10];
Fred* p = new Fred[10];
...
}

Select the best option,

► Fred a[10]; calls the default constructor 09 times
Fred* p = new Fred[10]; calls the default constructor 10 times
► Produce an error
► Fred a[10]; calls the default constructor 11 times
Fred* p = new Fred[10]; calls the default constructor 11 times
Fred a[10]; calls the default constructor 10 times
Fred* p = new Fred[10]; calls the default constructor 10 times

Question No: 8  (Marks: 1) - Please choose one
Which construct is the source for the creation of an object?

► Destructor of the class
► New operator  Click here for detail
► Delete operator
► Constructor of the class

Question No: 9  (Marks: 1) - Please choose one
this pointers are not accessible for static member functions.

► True  (Page 14)
► False

Question No: 10  (Marks: 1) - Please choose one
When a variable is define as static in a class then all object of this class,

► Have different copies of this variable
► Have same copy of this variable  Click here for detail
► Can not access this variable
► None of given

Question No: 11  (Marks: 1) - Please choose one
______ remain in memory even when all objects of a class have been destroyed.

► Static variables  (Page 111)
► Instance variable
► Primitive variables
► None of given
Question No: 12 (Marks: 1) - Please choose one
Given the following class
class Base{
    int Age=33;
}

How you can improve above class with respect to accessing the field Age?
► Define the variable Age as private
► Define the variable Age as protected
► Define the variable Age as private and create a get method that returns it and a set method that updates it [Click here for detail]
► Define the variable Age as protected and create a set method that returns it and a get method that updates it

Question No: 13 (Marks: 1) - Please choose one
The life of sub object is not dependant on the life of master class in __________.

► Composition
► Aggregation (Page 134)
► Separation
► None of the given

Question No: 14 (Marks: 1) - Please choose one
Which one is not keyword in C++?

► operator
► B_op [Click here for detail]
► const
► None of given

Question No: 15 (Marks: 1) - Please choose one
The >= operator can be overloaded.
► True (Page 140)
► False

Question No: 16 (Marks: 1) - Please choose one
Identify which of the following overloaded operator function’s declaration is appropriate for the given call?
Rational_number_1 + 2.325
Where Rational_number_1 is an object of user defined class Rational_number.

► Rational_number operator+( Rational_number & obj);
► Rational_number operator+(double& obj);
► Rational_number operator+(Rational_number &obj, double& num);
► operator+(double & obj);
Question No: 1 (Marks: 1) - Please choose one
A template provides a convenient way to make a family of

► variables and data members
► functions and classes Click here for detail
► classes and exceptions
► programs and algorithms

Question No: 2 (Marks: 1) - Please choose one
Which one of the following terms must relate to polymorphism?

► Static allocation
► Static typing
► Dynamic binding (How to program, page 1103) Click here for more detail
► Dynamic allocation

Question No: 3 (Marks: 1) - Please choose one
What is true about function templates?

► The compiler generates only one copy of the function template
► The compiler generates a copy of function respective to each type of data (Page 257)
► The compiler can only generate copy for the int type data
► None of the given.

Question No: 4 (Marks: 1) - Please choose one
Which of the following is the best approach if it is required to have more than one functions having exactly same functionality and implemented on different data types?

► Templates Click here for detail
► Overloading
► Data hiding
► Encapsulation

Question No: 5 (Marks: 1) - Please choose one
template <>
class Vector<*> { }

This is an example of partial specialization.

► True (Page 281)
► False
Question No: 6 (Marks: 1) - Please choose one
Classes like TwoDimensionalShape and ThreeDimensionalShape would normally be concrete, while classes like Sphere and Cube would normally be abstract.
► True
► False	Click here for Detail

Question No: 7 (Marks: 1) - Please choose one
A non-virtual member function is defined in a base class and overridden in a derived class; if that function is called through a base-class pointer to a derived class object, the derived-class version is used.
► True
► False	Click here for Detial

Question No: 8 (Marks: 1) - Please choose one
Assume a class Derv that is privately derived from class Base. An object of class Derv located in main() can access
► public members of Derv.  Click here for Detail
► protected members of Derv.
► private members of Derv.
► protected members of Base.

Question No: 9 (Marks: 1) - Please choose one
In order to define a class template, the first line of definition must be:
► template <typename T>  (Page 281)
► typename <template T>
► Template Class <ClassName>
► Class <Template T>

Question No: 10 (Marks: 1) - Please choose one
If there is a pointer p to objects of a base class, and it contains the address of an object of a derived class, and both classes contain a nonvirtual member function, ding(), then the statement p->ding(); will cause the version of ding() in the _____ class to be executed.
► Base
► Derived
► Abstract
► virtual  (not sure)
Question No: 11  (Marks: 1) - Please choose one
When the base class and the derived class have a member function with the same name, you must be more specific which function you want to call (using ___________).

► scope resolution operator
► dot operator
► null operator
► Operator overloading  (Page 204)  Click here for Detail

Question No: 12  (Marks: 1) - Please choose one
Non Template Friend functions of a class are friends of ______instance/s of that class.

► All  Click here for detail
► One specific
► All instances of one date type
► None of the given options

Question No: 13  (Marks: 1) - Please choose one
The find() algorithm
► finds matching sequences of elements in two containers.
► finds a container that matches a specified container.
► takes iterators as its first two arguments.  Click here for Detail
► takes container elements as its first two arguments.

Question No: 14  (Marks: 1) - Please choose one
If you define a vector v with the default constructor, and define another vector w with a one-argument constructor to a size of 11, and insert 3 elements into each of these vectors with push_back(), then the size() member function will return ______ for v and _____ for w.

► 11 for v and 3 for w.
► 0 for v and 0 for w.
► 0 for v and 3 for w.
► 3 for v and 11 for w.
Question No: 15  (Marks: 1) - Please choose one
Which of the following may not be an integral part of an object?

► State
► Behavior
► Protected data members
► All of given (not sure)

Question No: 16  (Marks: 1) - Please choose one
Which is not the Advantage of inheritance?

► providing class growth through natural selection.
► facilitating class libraries.
► avoiding the rewriting of code.  

Click here for Detail
► providing a useful conceptual framework.